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Administrator’s Guide
Introduction

Welcome to Bean Counting, the physical inventory counting system for small and medium sized
retailers. This document will help you start using our software to conduct your own in-house
physical inventory counts. The first part of this document steps the administrator through the
process of installing and configuring the Bean Counting package. The second part of this
document is an end-user guide that you are welcome to customize and use for your scanning
team’s training. If you wish to know what Bean Counting is like for the end user, you may wish to
skip ahead. The appendixes include a sample Area Tags and a sample store map.

A few definitions for terms that we use in the rest of this document:

« Terminal - the portable data collection terminal. There are several devices that are
compatible with Bean Counting, including the Cipherlab CPT-711, the Metrologic ScanPal2,
and the HandyScan 2000.

e« Computer - a personal computer running a relatively recent version of Microsoft Windows.
The Terminals typically come with a serial cable. Your computer will need either a comm.
port or a USB port and an inexpensive third-party USB-to-Serial adaptor.

« Program Folder - the folder where you installed the Bean Counting software. By default,
this is “"C:\Program Files\Bean Counting”.

e End-user - the people who will be conducting the inventory scan

Support and Training

Included with your Bean Counting package is an optional training session over the phone and web.
To get the most value from the training session, we require that users read through this

document and try to complete the installation of the program on their own so that the training
session can focus on the details of the system.

For end-user support calls, please ensure that the physical inventory scanning team, contacts
your organizations internal technical or physical inventory count support before contacting
Perceptus.

Please have your complete contact information, company name, version of the Bean Counting
software, and a description of error or the steps leading to the problem prepared before
contacting us at either of the following:

Email: support@perceptus.ca
Phone: 604-780-1480

What to Read Next

To get a feel for the actual inventory counting process with Bean Counting, skip ahead to the
“Scanning Team Guide”

Or continue reading the next section for the initial setup and configuration guide.



Initial Software Install

If you are reading this document, chances are that you have already downloaded and run the
Bean Counting installation. If not, please visit http://bean.perceptus.ca and download the latest
version of the software. Then run (i.e. “"double click” on the BeanCount-1.n.exe file). Use the
default options unless instructed otherwise.

Note: If you do not have Microsoft Access installed, please contact us to get an alternate
download that includes the MS Access Runtime. It is a larger download that we do not make
generally available on our website. You can tell if you have MS Access installed by looking at your
programs list — typically it is listed with the other Microsoft Office applications such as Excel or
Word.

After installation, you should find a menu in your programs (Start - All Programs in Windows XP)
list called “Bean Counting.”

Configuring a new Terminal

WARNING: these steps will install Bean Counting onto your portable Terminal. This process will
erase all data and programs from previous versions of Bean Counting, or other applications that
are on the Terminal. Do not complete this process until you are certain that you no longer
require the information on the Terminal.

1. Connect the Terminal to your computer with the special data cable. This cable is typically
bundled with the Terminal.

2. Determine the correct communications port to use. If you are unfamiliar with serial ports,
you may read Appendix D for help in determining the correct port to use.

3. Turn on the Terminal in "System” mode by pressing and holding 7 and 9, and then
pressing power (bottom right button), i.e. a total of three keys are to be used at the same
time. The Terminal should say “"System Menu” at the top. If you have successfully started
the terminal in System mode, then turn it off - no, that is not a typo.

4. Then start the Terminal in “"Kernel Mode” by pressing and holding 1 and 7, and then
pressing power. The Terminal should say “Kernel Menu” at the top of the screen.

5. Select "1. Program Download” and press Enter. Unless specifically instructed otherwise,
select RS232 on the "Download Program” screen and 115200 on the “"Baud Rate” screen.
You should see “"*Ready to Download*” on the screen.

6. On the PC, open Download.exe (a shortcut, "Download”, is installed in your Start menu by
the Bean Counting Windows installer) to send the BASIC interpreter (BC711.shx) to the
Terminal. The BC711.shx file can be found in your Bean Counting program folder (the
default is “c:\Program Files\Bean Counting”). The default settings are usually correct - if
they do not work, try COM2 instead of COM1.

7. If your settings are correct, you will see a progress bar on your PC screen. When the
download is complete, the Terminal will display “"***Complete***” and your PC will have a
“"Downloaded completely” message. Note: this task is normally done only once per device
to enable the Terminal to run the Bean Counting program.

8. Next we send the Bean Counting program, to the Terminal.

If you have just done step 7 above: The Terminal should automatically skip to the
“Baud Rate” prompt and then the wait for a Basic program mode if you press a key after
the "***Complete***” message. If it doesn’t, do the alternate instructions below.

Alternate:



10.

11.

Turn off the terminal by holding down the power button for about a second. Turn it on
again in “"System” mode (see step 2, 7+9+Power). Select 6. to "Download”. Select 2 for
“Basic”. Select 1 for "RS232", this is the cable connection from the Terminal to the
computer. Select 115200 BPS.

On your computer, open SynLoad.exe (a shortcut is in your Start > Bean Counting menu)
to send the Bean Counting program (CompilerFile.syn in your Bean Counting program
folder) to the Terminal.

Enter the Bean Counting unlock key that corresponds to the Terminal’s serial number. To
do this, you must visit http://bean.perceptus.ca. Create a login account (if you don't have
one already). Then send an email to sales@perceptus.ca so that we can have your license
activated and associated with your account. Once the license has been added to your
account, you should login to our website again. Then enter the Terminal’s serial number,
and add a Bean Counting Inventory program license to the device. Finally, retrieve the
unlock keys. Alternatively, email sales@perceptus.ca the serial nhumbers of all of your
Terminals and we will create the login account and other entries for you. Enter the unlock
key on the Terminal from the Options (5), then Keys (2), then Inventory (1) menus.
Without the unlock key, the device will remain in trail mode. Up to 30 barcode scans are
allowed in this mode.

Turn on the Terminal. Press a key to get past the Perceptus branded splash screen. When
you get to the main menu of Bean Counting, look at the date and time. If they are
incorrect, follow these steps to change it: Turn off the Terminal. Turn it on in System
mode (7+9+Power). Change the time in the settings. Note: The time displayed in Bean
Counting is only for user convenience, so its configuration is optional.

Installing a new version of Bean Counting

1.

2.

To upgrade the computer side software, first back up the Bean Counting database
manually. Browse to your Bean Counting installation folder (default: “C:\Program
Files\Bean Counting\”) and copy the “"Bean-Counting.mdb” file to a safe place. This will
save any customizations that you have made so that you can refer to them later. Then
download and run the new installation file for Bean Counting.

To upgrade to a newer version of the Bean Counting application on the Terminals, you
need to repeat the steps from “Configuring a new Terminal”; however, begin at Step 7.

Installing the SKU lookup list

Using the optional SKU lookup feature allows you to check that the barcode that is scanned is one
that is recognized by your other systems. Unless otherwise instructed, the SKU lookup list should
contain the exact same text that is read by your POS barcode scanner. These steps will provide
hints on how to create the list of SKU’s from your POS system, and then how to put the list onto
the Terminal.

1.

2.

vk

Using either the Bean Counting Application on your computer, or your POS vendor
provided software, create the SKU List.

The SKU list is a simple text file with only a single SKU on each line. You may have double
quotes around the SKU, but no other formatting is permitted.

Bean Counting supports SKU’s up to 20 characters in length. SKU’s longer than this will be
truncated. We generally recommend that no more than 20 000 SKU’s be in the lookup list.
In some businesses, you may need to filter out inactive SKUs from your file.

Export the list to a text file.

Open the text file in a text editor such as Notepad to make sure that it is in a compatible
format. It should look like one of the following:
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[ tblLookup1.txt - Notepad [ [m] B
File Edit Format WView Help
0030101 * [ tblLookup... [5[m] 4
iggggfgg oo File Edit Format View
100323385 Help
lGGEQEEQ "10030101" —
10029872 " "

10029880
10028118 " "

10030105
100281149 " "

10033385
10030114 " "

10029859
10020104 " Zan

10029872
10029883 " "

10028118
10030106 " "

10028119
10030103 "10030114"
10029881 " "

- 100301047 -

Note: Notepad is a basic text editor. For large operations, a more advanced editor can be
orders of magnitude faster. We suggest Crimson Editor. It is freely available at this
website: http://www.crimsoneditor.com/.

6. We now upload the SKU Lookup to the terminal. If you are installing a new SKU lookup
list over an old one, you should delete the original file from the Terminal. On the Terminal,
select (5), then "Mem/Files”, then “Delete”, then select SKU Lookup.

7. On a Terminal which already has the Bean Counting Software running, select 5, “Other”, 6,
“Receive Lookup”. Press 1 to put the Terminal in waiting mode.

8. On the PC, run FileTransfer.exe (a link is installed in your Programs menu). Select
“Download Lookup.” Select “Start.”

Creating Scanning Slips

Open the Bean-Counting Database. Use the tools there to create scanning slips. Scanning slips
are used to help break down the store into areas and sub areas for the inventory count.

For most users, the standard scanning slips will be fine. In the Bean-Counting Database, click on
"Configure Slip List". Select a slip type of "Normal" and a slip count as high as you like, say 100.
You will require one slip per area of a store — 100 slips are usually sufficient for a 2000 square
foot store. Close the configuration form, and then click on "Preview and Print Slips". A preview of
the slips to be printed will be generated. Now, selectively print whichever pages you need
through the regular Windows printer dialogs.

Sample inventory slips are provided in a separate PDF (Sample Inventory Slips.pdf). These
should be sufficient for your testing and evaluation of Bean Counting. An overview of how to use
the slips is in the end-user documentation.

If you need fewer than 200 Area Tags, you can use the "Simple Inventory Counting Slips.pdf” file
- a link to this file is normally created in your Programs menu when Bean Counting is installed. It
is a PDF file that you can print for your inventory slips.

Note: You must use differently numbered slips for each store that will be scanned by the
Terminals without an intermediate data unloading. To clarify, it is OK for two sites to use Area
Tag 001 if the portable Terminal is unloaded between site counts. However, it is not OK for two
sites to use Area Tag 002 if the same Terminal will be used to scan both sites before returning to
the Office to remove the physical inventory count data - the running counts will still reflect the
scans at the first store, so they will be “wrong” at the second site.

3



Scanning the Inventory

If you are following this document from beginning to end, then at this time, you are ready to scan
your inventory. Skip to the End-User Guide, Appendix A, where we have provided end-user
scanning documentation. It is intended to be suitable for editing and then distributing to your
physical inventory staff as a training manual.

Program Settings

There are several options in the Terminal Software that are not documented in the End-User

Guide,

Appendix A for brevity and to keep some features “known” to only the administrators of

the physical inventory counts.

The important ones are these:

Quantity entry. Enabling this option will prompt for the quantity of items scanned after
each SKU is read. This is useful, and probably desirable for warehouse situation where
there are a lot of identical items in a well organized fashion, but probably undesirable for a
store setting.

[Main] - Other (5) > Options (1) > Prompt for Qty. (4).

SKU Validate. This enables/disables the checking of the scanned SKU against the SKU
Lookup list that is optionally installed on the Terminal.

[Main] = Other (5) - Options (1) > SKU Validate (1).

Custom Fields. These can be used for anything such as the Employee Number of the user,
the Site ID, the date, etc. Each field has a maximum of 5 alphanumeric characters. All
custom fields are appended to each scan, and are transmitted to the PC for later reporting
and archiving.

[Main] - Other (5) > Custom Fields (5)

Receiving Scanned SKUs from the Terminal

Once you have scanned all the items of which you are taking inventory, you need to follow these
steps to upload the data from the Terminal to your computer.

whh e

Nous

®

10.
11.
12.
13.

14.

Plug in the cable or cradle between the Terminal and the computer.
Open FileTransfer.exe. (Start > Programs - Bean Counting > FileTransfer)
Set the COM port. This depends on the computer, see Appendix D: Determining the
Correct Communications Port.
Set the Baud rate to 115200.
Select “"Upload Count Data”.
Click on Start. You will be prompted for a name and location to save the incoming file.
We recommend that you include the date, the stores scanned, and a unique portion of the
portable Terminal’s serial number in the filename. E.g. "20041215-Store101-SN401.txt.”
Once you have clicked “Save” in the file selection window, the PC program will enter a
waiting mode.
On the Terminal, from the Main Menu, select “"Send to PC” (2)
Press a key on the Terminal to get past the information screen.
You should see a progress bar with the status of your upload.
You will end up with a simple, comma separated value, text file on your PC.
Repeat the previous steps for each Portable Terminal.
Now you can use the “Import Uploaded File” and “Export Scans” buttons of the Bean
Counting PC software to combine and format your scans to better match your POS
software.
To import each file:

a. Open the Bean Counting Application.
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b. Click on “Import Uploaded File” from the Main Menu.

c. You must now import all files from your scanners one at a time.

d. Choose a common “Scan Round” that describes the series of scans that you are
currently analyzing. Use a description that applies to your entire organization or
division. E.g. “2005-01".

e. Click on the Open Folder icon to browse and select the first data file.

f. Enter a File Description that applies to the specific file, e.g. [SiteID] + [Terminal
ID].

g. Then click on “Start Import” to process the first file.

h. Now import all of the other files from the current site. Use the same “Scan Round”
name but use a different “File Description” for each file.

15.To use your scan data, there are three options, listed in order of preference: importing the
files directly into your POS; creating and exporting a summarized Excel or .csv file for
importing into your POS; or creating a variance report with Bean Counting and entering
the variance into your POS. Importing the files directly into your POS is the preferred
option since it involves fewer steps. Each option is described separately below.

Exporting a Summarized Inventory Count

1. Go to the Main Menu of the Bean Counting Application. Then click on “Export Scans”.
2. Most users will use the “Scan Export - SKU and Quantity Only” report. Double click on the
report name to open it. The default configuration for the report is as displayed in this

screenshot:
8 QBF - Query Builder - [3] x|
Report Name |5can Export - SKIJ and Quantity Only Author |Perceptus Run Report/Query |

Data Source [<tblScans> - Date [2004-12-17  MTotals

You can filter and sort with this form.
The most frequently used filter fields are the "ScanRound” and "Custom™” fields.
After (optionally) customizing the fitters, click "Run Report/Query”.

Select a Field (dbl-click to delete) Sort  Operator Total Show Data  Criteria value 2nd Value (if Between) -

Jst 52 A || ~leropey =] ¥ &2 | [~

[Quantity 52 | TpEa || | [5um =] = &2 | [~
W |[5canround =] _ | [where =] ¥ [ 2| &3

[custom 1 IR ] (e || =
* JE2 | TREa | JEa | = B3 | [~

ﬂ

In the screenshot, a filter "January” for the ScanRound field has been added. This will limit
the report to only records which were imported with “January” in the Scan Round field.
You may also wish to add a site ID filter by selecting the Custom* field in the “Select a
Field” column and entering the Site or Location ID in the “Criteria Value” field.

Record: 4 1 k| M| k¥ of 1(Fitered)




Then click on “Run Report/Query” to preview your Scan Export. On the next screen, you
will have the option of saving your file to an Excel file, a plain text file, printing the file,
and some other options. Choose the method that will be compatible with your business
processes and POS software.

Import Your Data Directly Into Your POS

Your POS system may be able to read the Bean Counting Terminal files directly. A good file
importer will be able to map columns to the correct fields required by the POS. If you choose to
do this, the following file tips and information will be handy:

1.

Avoid using Excel or other spreadsheet software to manipulate your data files. They often
remove leading zeros without notice. At the very least, double check the values after you
have edited a scan file with a spreadsheet program.

The order of the fields in the SKU upload text files is:

“Areatag”, “Line”, "SKU"”, “Quantity”, "Custom1”, “"Custom2”, “"Custom3”, “"Custom4”.

For most POS systems, the critical fields are "SKU”, “"Quantity”, and sometimes, the
custom field which was used to store the site or location ID.

Each row in the text file represents a single “scan” (that has not been deleted). If the
quantity prompting is disabled, then each row will have a quantity of 1, if prompting is
enabled, the quantity field will vary appropriately. Each field is separated by a comma.

Creating a Variance Report in Bean Counting

You can create a variance report using the some special tools in the Bean Counting Application.

1.

3.

You first need to create an inventory export from your POS. The method varies by POS
system. Some POS systems have inventory exports to Excel or .csv, others will have a
report which you can mangle into an Excel file, while others may prefer to connect to the
database directly with an export tool. If you need help figuring out a methodology,
contact your POS vendor first. Alternatively, we at Perceptus might be create a solution
for you.
We recommend finalizing your inventory file in Excel. Create and arrange a worksheet
with the following columns to match our import specifications:
e« Column A: ScanRound - a text value that you create to identify this scanning
round. E.g. January2005.
« Column B: SitelD - the site of the inventory record.
e« Column C: SKU - the SKU.
e Column D: Quantity - the quantity of the SKU at the SitelD.
« Column E: Style - if you have multiple SKUs per Style, then enter the style in this
column, if not, then copy the SKU column.
« Column F: Cost - the cost of the item. Fill in this field if your variance entry into
your POS requires a cost value. Else, enter zeros.
e Column G: Price - the retail price of the item. Fill in this field if your variance entry
into your POS requires a retail price value. Else, enter zeros.

Open the Bean Counting Application. Click on Import POS Inventory. You will see the
screen below.



B Import Inventory n

Import POS Computer Inventory e

Use this form to import the inventory amounts from your point of sales system. If your POS system incudes variance
importing of physical inventory counts, then you do not need to use the variance reports of Bean Counting. If your POS
does not provide count importing, then export your POS inventory and create an Excel file with the following columns of
data:

Column A: ScanRound - & text valus that you create to identify this scanning round, E.g. January2005.

Column B: SiteID - the site of the inventory record.

Column C: SKU - the SKU.,

Column D: Quantity - the quantity of the SKU at the SiteID,

Column E: Style - if you have multiple SKUs per Style, then enter the style in this column, if not, then copy the SEU column.

Column F: Cost - the cost of the item, Fill in this field if vour variance entry into your POS requires a cost value. Elee, enter zeros,

Column G: Price - the retail price of the item. Fill in this field if your variance entry into your POS requires a retail price value. Else, enter zeros,

Once the Excel spreadsheet has been created, select all data by highlighting columns A through G. Then go to Menu
Bar -> Edit -> Copy. Then swith back to this form. Click in the first "cell” of the table below. Go to Menu Bar -=> Edit -=
Paste Append. The table below should be populated with your inventory information.

| [ ScanRound | SitelD | SKU [Quantity[ Style | Cost | Price | DateAdded

TESAT | 9780345429032 [2.00  2005-11-14 11:24:36 PM
TEST TESAT | 9780345429032 | |2.00 | 2005-11-14 11:24:36 PM
TEST TESAT | 9780345429032 | [2.00 | 2005-11-14 11:24:36 PM
TEST TESAT | 9780345429032 | |1.00 | 2005-11-14 11:24:36 PM
TEST TESAT | 9780345429032 | |1.00 | 2005-11-14 11:24:36 PM
TEST TESAT | 9780345429032 | |2.00  2005-11-14 11:24:36 PM
TEST TESAT | 9780345429032 | [1.00 | 2005-11-14 11:24:36 PM
TEST TESAT | 9780345429032 2.00 | 2005-11-14 11:24:36 PM

| Record: 14| 4 ] 1 [ri|rx]of 22

R i e i i

4. In Excel, select all of your data columns. Then Go to the Menu Bar - Edit > Paste Append
to add your inventory to the inventory table in Bean Counting.

5. Close the Import Inventory form. Then open the Configure Variance form. Screenshot
below.

B Configure Variance Report n

ﬂ

Computer POS Amounts Physical Count
Scan Round hd Scan Round [ hd

This field accepts * as a wild card.

For example, if you wish to indude all
records with a File Description that start
with "Site 101", enter "Site 101*",

View Variance in Table Format

View Variance in Report Format ‘

TMPOT TP oS ey T

6. Select the inventory records and which physical scan records to include in the variance
report.

7. Then click on either View Variance in Table Format or View Variance in Report Format to
generate a variance report.

8. Then transfer these values into your POS software by whatever means is supported by it.

Clearing the Terminal Data

Once you have downloaded your data from the scanner, and you are absolutely certain that you
don not require the data any longer, you can delete the scanned files.



On the Terminal, select “"Other” (5), then “*Mem/Files” (3), then “Delete” (1), then select
“Clear Scanned!” (4). This action will erase all scan data that is on the portable Terminal.
Be extremely cautious when doing this!

Also clear the “Backup Log” (1). The Backup Log keeps track of most actions that affect
the scanned data. It is different from the regular data file in that it also records deletions
and various timestamps. See Appendix E for instructions on how to retrieve this
information. The Backup Log is automatically trimmed; however, if you are completely
finished processing a scan, it is safe to purge the backup log.
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Scanning Team Guide
The physical inventory counting system

Introduction

Sometime during the next several minutes, you will probably wonder "Why all this equipment to
do an in house, physical inventory count?” The biggest reasons are time and accuracy - the
scanners and barcodes make collecting data much quicker than a manual tabulation, and the
processes include many checks to avoid many potential errors that can occur when doing an
inventory count.

The Device

To avoid some confusion, we’ll cover the basics of the device:

The barcode scanner is embedded at the top of the
device.

The largish yellow button is the barcode scanner trigger.
In Bean Counting, you only need to press this button, i.e.
do not hold it down.

The power button is at the bottom right. You need to
hold it down for about 1 second for it to do anything
(this prevents accidentally powering on or off the
device).

The “Enter” key is below the “3”. Different models have
different labels for the button.

“BS” is the backspace key for text entries, and it has
special uses within Bean Counting.

Pressing “Alpha” allows you to enter letters and symbols
instead of numbers via the keyboard.

Scanning a Store Pre-work

4.

1. Affix the Scanning Slips to shelves, tables, racks, etc.
2.
3

Circle the section type of the Area to which the Scanning Slip belongs.

Fill in box “# Lines Used” with the number of lines in the area - this helps to avoid missed
sub areas during the inventory count.

Prepare a store map so that you know how many slips have been used, and where they
were placed.

Before scanning ensure that all devices have the same version of the software. This is
displayed on the Power On splash screen.

If you are validating each SKU that is scanned, make sure that you have a SKU Lookup
table by going to the “"Other” (5) menu, then “Mem/Files” (3). Look for a non-zero value
for the SKU lookup. Note that the actual number of records will vary slightly if
unrecognized SKU's are added to the list during the inventory count ("Add NOF to Lookup”
option).



8.

9.

Ensure that the Terminal has a validated Bean Counting serial number entered. If it is not,
you will be unable to scan more than 30 items. There are warning prompts when you turn
on the Terminal, and a second one before you start Scanning if the key is missing.

For quicker scans, you may wish to organize your stock so that the barcodes are easily
accessible.

Much of this pre-work can be done before the “scanning day”.

Scanning - The folks with Portable Scanners

1.

wn

ook

10.

11.

12.

13.

14.

15.

16.
17.

Turn on the portable Scanner (the power button has must be held down for about a
second - this helps to prevent accidental power ups).

Set the store location. Go to “Other” (5). Then “Custom” (5). Then “User Field 1” (1).
Enter your store number. This number will be saved with each scan so that we can
differentiate the records, later, at the office.

Press "ESC” as many times as necessary to return to the Main Menu.

Now we begin scanning. Select “Take Inventory (1)".

You are prompted to scan an Area Tag - this is the barcode that is on the Scanning Slips
that were affixed during the pre-work.

You will then be prompted for the line number.

Next, you begin scanning the barcodes of your inventory. Press (do not hold) the big
button to trigger the barcode scanner. Scan systematically to minimize errors. For
instance, use “hard” boundaries for the division between areas and work from top to
bottom, left to right.

You should hear a “nice” beep when it reads the barcode and recognizes it. The running
totals for the area and line are updated at the bottom of your screen.

If you get a "SKU Not Found” error, the SKU was not in the SKU lookup file. It may be an
old SKU, a vendor SKU, or some other error. Check if the value on the screen matches
the barcode on the tag. If they do not match, cancel the scan and try again. If they do
match, either move the item out of the area for examination later, or select “Yes” to
accept the barcode.

If the barcode is missing, or can not be scanned, you can do a manual entry of the SKU by
pressing “"FN” and “1” simultaneously. Then key in the SKU with the keypad and hit enter
(this also works everywhere a barcode scan is requested, such as when scanning an Area
Tag).

If you think that you have made an error, you can press the “.” key to browse the values
that you have scanned within the line. Arrow up or down. To delete a record, press the
“BS” key. You can clear the entire line by pressing “7”. Press “.” to go back to scanning in
that line. Note: This is a shortcut. The longer equivalent is to escape back to the Main
Menu, select Browse/Delete (3), scan the area tag, enter the line, browse and delete, then
Escape back to Main Menu, etc.

When you have completed a line, read the running total at the bottom of the screen and
write that value on the Scanning Slip in the “Line” column.

Press ESC and you will be requested to enter the next line number. Once entered, you can
begin scanning to this new line.

When an area is complete, copy the running total from the screen to the Scanning Slip,
box beside “Total”. Fill in the “"Scanner Initials” box; write the scanner’s abbreviated serial
number in box “Terminal ID”, and move on to the next area.

Press ESC twice to get back to the Area Tag prompt. Scan the next Area Tag.

Rinse and repeat from step 5 as necessary.

Scanning - The folks doing the Cross Count

1.

The persons doing the cross count are the ones who will make this entire system accurate
- make sure these people can count to at least 30 with confidence and reliability.©

-2-



2.

3.
4.

Go to a line and manually count the number of items within the line. If your count
matches the “Scan Quantity”, put a check mark in the “"Quantity Checked” column.

If all the line totals have been verified, initial the sheet and move on.

If they count does not match, coordinate with the Scanner to establish a “Verified
Quantity”. Use the “"Browse/Delete” menu of the scanning program to find and correct the
discrepancy. Records can be deleted in the Browse/Delete menu, and added from the
scanning menu (you can still use the “.” Shortcut between Browse and Scan modes).

Miscellaneous Notes and Tips

1.

2.

3.

The optimum distance at which to hold the scanner varies by the size and type of the
barcode - invariably, it gets easier for the scanners as you get used to the device.
Ambient lighting makes a difference. Bright, direct sunlight can cause problems, as can
too dim lighting. Move stuff, use your shadow, or turn on additional lights.

Barring hardware defects, there is no data loss if batteries die and need to be replaced
(there should be a backup battery built into the device). However, we recommend fresh
batteries for each store scan - you can use the partially used batteries in other things.
Keep the people who are scanning separated to have more room to work. It also makes it
easier to hear the “scan successful” beeps.

If the device has a problem, such as a lock up or the barcode scanner ceases to scan, you
can reboot it by powering it on and off, just like your PC. Again, your data should be safe
during the reboot.

You can browse the list of area tags used by pressing zero (*0”) from the first screen after
entering the Browse/Delete from the Main Menu.



Appendixes
Appendix A: Sample Area Tag

*0000*
Circle Section Type
4' 8' roll bar 2 way 4 way bunker
shelves table window slat wall access  jewelery
manual ticket

Notes

Scan Quantity | Verified
Line] Quantity | Checked | Quantity

1

2

3

4

5

6

7

8

9

Total
# Lines Used Scanner Initials | |Verifier Initials

fermina 15 LT

*0000*




Appendix B: A Sample Store Map

A store map helps the scanning team keep track of how many Area Tags were used in the store.
It also helps in planning for the physical inventory scan. Don‘t forget to include things like your
back room storage, boxed stock, display cases, and hidden drawers.
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Appendix C: Creating Barcodes

Do you have some stock that does not have barcodes? If you want, you can create barcodes in
Bean Counting itself.

On the Main Menu of the Bean Counting program, click on the “"Barcode Label Printer” button.
“Edit the Barcode List” by simply entering the values for your barcode and the quantities for each
barcode. Then preview and print your labels by clicking on the Printer icon. The report is
designed for Avery 5160 labels. If you have the full version of Microsoft Access you can
customize this report to use different labels or make other design changes.

The barcodes in Bean Counting are in code 39. The “Free 3 of 9” barcode font was installed with
Bean Counting. It is available here: http://www.squaregear.net/fonts/free30f9.shtml

Appendix D: Determining the Correct Communications Port

If you are plugging the cable that came with your Terminal cable directly into your computer, you
are using one of your computer’s serial ports. Often, the serial port number is embossed near the
port. If not, you can determine the correct port through a bit of guessing and testing.

First, find out how many serial ports your computer has and what port numbers are assigned to
them. In Windows 2000/XP, click on “Start” and then “"Run”. In the little window that appears
type in "devmgmt.msc” and click OK. Expand the “Ports (COM & LPT) branch of the tree. There
you will see a list of all Comm Ports installed and their Port #. There usually are not more than 3.
Test each one with our software.

If you are using a USB to Serial adaptor, do the exact same steps. Each USB-to-Serial vendor
has their own driver. Usually you can configure the Comm port that the device uses. To change
this, usually one would right-click on the USB-to-Serial device and click “Properties”. Then
browse the tabs and option windows (such as “Advanced”) until you find an option to choose the
port to use. We recommend the lowest available port number that is port 4 or lower.

Appendix E: Viewing / Saving the Backup Log

The Backup Log is primarily a development tool; however, it is also a useful tool to help insure
against tragic user error. It records an abbreviated version of your scans plus other run time
information such as deleted records and device settings.

You can view the Backup Log on your PC by using any standard terminal program and using
“Backup Upload” (2) from the *“Mem/Files” menu.

A good, free terminal program that we recommend is Tera Term Pro. Visit this site to get and
install a copy of Tera Term Pro ver. 2.3 for Windows 95/NT
http://hp.vector.co.jp/authors/VA002416/teraterm.html.

Close any other Bean Counting programs that are open. Then open the Tera Term program and
create a new connection with the same port settings that you use for FileTransfer.exe. Once that
is setup, use the “Backup Upload” (2) option from the "Mem/Files” menu. You should see your



scan information, SKU lookup list, and other data scroll in the window as it is uploaded from the
portable - it should be in "readable" text and numbers. If it looks “greek”, then you need to
check the port speed settings. Make sure that you are using 115200 bps, 8 data bits.

Once you are able to view the data, the next step is to record the data to a file. Do this by
creating a new log file from the File menu. Then run the upload from the Terminal again. When
it is done, close the program and open the "log" file in a text editor.

The actual file consists of several different files that we upload. You are welcome to view the data.

Appendix F: SKU Info Viewer

The Bean Counting software has a bonus module, the SKU Info Viewer. You can create a
specially formatted data file which will let you use the handheld Terminal to look up color, size,
price, description, and some custom information of your inventory. It is useful for retailers who
do bulk markdowns in stores and need to create price tags with the discount prices. You will
need to contact Perceptus for details on the import specifications for this feature. The device has
a capacity for about 8000 SKU Info records.

Once the SKU info file is loaded, follow these steps to use the SKU Info Viewer:

e Turn on the Terminal (press and hold the bottom right button for about a second).

e Press 1 to go past the splash screen.

« From the Main Menu, press 4 for "SKU Info Tool”

e You will be prompted to “"Scan a SKU to Lookup”. Just press the big button in the centre
to trigger the barcode scanner. You can also do a manual entry with FN+1.

e After a successful barcode scan, the style, regular price, sale price (*Cur Price”), and some
other information will be listed. For markdowns, you will use the “Cur Price” to make the
new price sticker.

* You can press barcode trigger (or do a manual entry) while the previous SKU information
is on the screen.

e If you have trouble, try turning the Terminal off and on with the power button.



